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Thank you very much for purchasing the EGX-20.

e To ensure correct and safe usage with afull
understanding of this product's performance,
please be sure to read through this manual
completely and store it in a safe location.

e Unauthorized copying or transferral, in whole or in
part, of this manual is prohibited.

e The contents of this operation manual and the
specifications of this product are subject to change
without notice.

e The operation manual and the product have been
prepared and tested as much as possible. If you
find any misprint or error, please inform us.

¢ Roland DG Corp. assumes no responsibility for
any direct or indirect loss or damage which may
occur through use of this product, regardless of
any failure to perform on the part of this product.

Roland DG Corporation



——  For the USA

FEDERAL COMMUNICATIONS COMMISSION
RADIO FREQUENCY INTERFERENCE
STATEMENT

This equipment has been tested and found to comply with the
limitsfor aClass A digital device, pursuant to Part 15 of the
FCC Rules.

These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated
in acommercia environment.

This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance
with the instruction manual, may cause harmful interference
to radio communications.

Operation of this equipment in aresidential areaislikely to
cause harmful interference in which case the user will be
required to correct the interference at his own expense.

Unauthorized changes or modification to this system can void
the users authority to operate this equipment.

The /0 cables between this equipment and the computing
device must be shielded.

—  For Canada

CLASSA NOTICE

This ClassA digital apparatus meets all requirements of the
Canadian Interference-Causing Equipment Regulations.

CLASSE A AVIS

Cet appareil numérique de |a classe A respecte toutes les
exigences du Reglement sur le matériel brouilleur du
Canada.

ROLAND DG CORPORATION
1-6-4 Shinmiyakoda, Hamamatsu-shi, Shizuoka-ken, JAPAN 431-2103
MODEL NAME : Seethe MODEL given on therating plate.
RELEVANT DIRECTIVE : EC MACHINERY DIRECTIVE (98/37/EC)
EC LOW VOLTAGE DIRECTIVE (73/23/EEC)
EC ELECTROMAGNETIC COMPATIBILITY DIRECTIVE (89/336/EEC)




How to Use This Manual

Be sure to read through this manual when using the EGX-20 for the first time.

This manual explains mainly the following information.
 Connecting to a computer installing a blade, mounting an engraving workpiece, and the like
« Installing the driver software on the computer
 The procedure for creating a nameplate using Dr. Engrave (a text-engraving program)

You can aso install and set up the following programs on the included Roland Software Package CD-ROM and use them on your
compulter.
* Virtual MODELA (a program that simulates cutting results obtained with 3D Engrave)
* Dr.Engrave (atext-engraving program)
« 3D Engrave (a program for creating reliefs)
» Windows driver (a software driver for using the EGX-20 with Windows)
The manuals for these (except for the manual for the driver) are in electronic format.
Refer to them for detailed information on use.

Manuals in Electronic Format

You can view the manuals in electronic format (PDF files) from the setup menu that appears when you insert the Roland Software
Package CD-ROM in the CD-ROM drive on your compulter.
Load the Roland Software Package CD-ROM in the computer's CD-ROM drive and view the manualsin electronic format as required.

x| Toview adescription of the program, click the (i) button. To view amanual, click
the(Z) button.

==Roland Roland Software Package

for PICZA, MODELA, CAMM-2, CAMM:3 A PDF manual is available for programs listed with a(Z) button.
Acrobat Reader isrequired to view PDF files. If Acrobat Reader is not already
e -l installed and set up on your computer, then the setup program for Acrobat Reader

| startsautomatically, allowing you to install and set it up.

| @ wirtual MODELA 7
“iiat b aa This adds thickness to a flat
™ brlEngragd 5 .a 7 (two-dimensional) araphic to create a
g ,ﬂ e three-dimensianal farm.

& 3D Eni rave. | rou can also add thickness toimages
5 %. such as illustrations.

& windows Driver & 1]

If¥itual MODELA is installed and setup,
you can preview the shape after cutting

Go to Roland DG Corporation Homepage

e

Help

After you have installed and set up the programs, you can view help for each that contains information similar to the PDF files.

In Windows, click [Start]. From the menu, point to [Programs], then [Roland 3D Engrave], then select [3D Engrave Help]. The help
window appears.

In the same way, point to [Roland Dr. Engrave] and select [Dr. Engrave Help], or point to [Roland Virtual MODELA] and select [Virtual
MODELA Help].

Alternatively, start the respective program, then from the [Help] menu, select [Contents]. The help window appears.
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To Ensure Safe Use

About AWARNING and ACAUTION Notices

AWARNING

Used for instructions intended to alert the user to the risk of death or severe
injury should the unit be used improperly.

ACAUTION

pets.

Used for instructions intended to alert the user to the risk of injury or material
damage should the unit be used improperly.

* Material damage refers to damage or other adverse effects caused with
respect to the home and all its furnishings, as well to domestic animals or

About the Symbols

LN

"danger of electrocution."”

The A\ symbol alerts the user to important instructions or warnings. The specific meaning of
the symbol is determined by the design contained within the triangle. The symbol at left means

®

The ® symbol alerts the user to items that must never be carried out (are forbidden). The
specific thing that must not be done is indicated by the design contained within the circle. The
symbol at left means the unit must never be disassembled.

€

The . symbol alerts the user to things that must be carried out. The specific thing that must
be done is indicated by the design contained within the circle. The symbol at left means the
power-cord plug must be unplugged from the outlet.

AWARNING

®

Do not disassemble, repair, or
modify.

Doing so may lead to fire or abnormal
operation resulting in injury.

Ground the unit with the ground
wire.

Failure to do so may result in risk of
electrical shock in the even of a mechanical
problem

O

Do not use with any electrical power
supply that does not meet the

ratings displayed on the AC adapter.

Use with any other power supply may lead
to fire or electrocution.

O

Do not use with any power supply
other than the dedicated AC adapter.
Use with any other power supply may lead
to fire or electrocution.

O

Do not use while in an abnormal
state (i.e., emitting smoke, burning
odor, unusual noise, or the like).
Doing so may result in fire or electrical
shock.

Immediately unplug the power-cord plug
from the electrical outlet, and contact your
authorized Roland DG Corp. dealer or
service center.

Use only with the power cord
included with this product.

Use with other than the included power cord
may lead to fire or electrocution.



ACAUTION

O

Do not use with a damaged AC
adapter, power cord, or power-cord
plug or with a loose electrical outlet.
Use with any other
power supply may
lead to fire or
electrocution.

Do not injure or modify the electrical
power cord, nor subject it to
excessive bends, twists, pulls,
binding, or pinching, nor place any
object of weight on it.

Doing so may

damage the

electrical power <\

cord, leading to

electrocution or

fire.

<

When not in use for several hours,
unplug the power-cord plug from the
electrical outlet.
Failure to do so may
result in danger of
shock, electrocution,
or fire due to
deterioration of the
electrical insulation.

When unplugging the electrical
power cord from the power outlet,
grasp the plug, not the cord.
Unplugging by
pulling the cord
may damage it,
leading to fire or
electrocution.

Do not attempt to unplug the power-
cord plug with wet hands.

Doing so may
result in electrical
shock.

Do not allow liquids, metal objects
or flammables inside the machine.
Such materials

can cause fire. %

\/

Install on a stable surface.
Failure to do so

may result in falling f
of the unit, leading [ /// /7
to injury. —_— )

]

Do not inadvertently allow the
hands,or hair near the rotating parts
while in operation.

Doing so may result in injury.

Do not touch the tip of the blade
with your fingers.
Doing so may result in injury.

When you're finished,
wash your hands to
rinse away all _

cuttings.

Wear dust goggles and mask during
use.

Cutting dust
may scatter,
causing bodily
injury.




About the Labels Affixed to the AC Adapter and Unit

These labels are affixed to the body of this product and the AC adapter. The following figure describes the location.

Handle tool with care.

Model name

Rating label

Do not use with any electrical power supply
that does not meet the ratings displayed on
the AC adapter.

ACAUTION A ACHTUNG
DISCONNECT MAIN PLUG FROM Losen Sie den NetzanschluB,

| SUPPLY SOCKET WHEN NOT IN USE _ wenn das Gerat nicht
MAIN LEADS COLOR CODE: | verwendetwird.
BROWN':LIVE, BLUE:NEUTRAL Die Farbkodierung des
A ATTENTION Netzkabels lautet folgendermaBen:
Quand la machine n’est pas Braun:Spannung, Blau:Masse
utilisée déconnecter le AEs

| céble de la prise de courant EBBERLZVEAE,
Code des couleurs ACTH#74%&a> > b 5IRNT
Marron:Phase, Bleu:Neutre T,

In addition to the AAWARNING and ACAUTION symbols, the symbols shown below are also used.

NOTICE : Indicatesinformation to prevent machine breakdown or malfunction and ensure correct use.

N—
|§ : Indicates a handy tip or advice regarding use.



EGX-20 USER'S MANUAL

Getting Ready
" What You Can Do with the EGX-20

* You can engrave a plate with text or shapes to create a nameplate or the like.
Using Dr. Engrave, the included 2D engraving program, you can easily engrave anything from simple text to complex designs
to produce high-quality engraved plates.
See --> p. 16 "Creating a Namepl ate"

« You can cut thick materials up to a depth of 7 mm to create reliefs and other forms.
Using 3D Engrave, the included 3D engraving program, you can easily produces reliefs and other three-dimensional engraved
forms.
See -->p. 28 "the 3D Cutting Mode"

" Check the Included Items

AC adapter: 1 Power cord: 1 cutter: 1
(with cutter holder)

[© ]
CC(——=3
(€
Depth regulator noses Adhesive sheet: 1 Test-use plate material: 1

(large 1 and small 1)

Hexagonal screw driver: 1 Hexagonal wrenches User's Manual: 1
(large 1 and small 1)

Roland Software Package
CD-ROM: 1




1 Getting Ready

Names and Functions

The names of the parts of the EGX-20 are as follows.

Front

Spindle unit Switch Panel

)

o
-[m’ —— Movement button
O— Speed control

o
o
o
SPEED
rp.m

Z-axis light

©®

@]

e

— Spindle Speed

_ 5 control
Power light @ +——Power button
- | 5
View light —— @ L View button
.. . —1 0
Origin Set light =)+ Origin Set button

—

Depth regulator unit

Rear

Parallel connector

AC adapter jack




EGX-20 USER'S MANUAL

1 Setting Up and Connection

Setting

NOTICE Never install this unit in any of the following situations, asit could result in damage:
 Places where the install ation surface is unstable or not level.
* Places with excessive electrical noise.
* Places with excessive humidity or dust.
* The EGX-20 generates heat when used, and should not be installed in an area with poor heat radiation
characteristics.
» Places with excessive vibration.

Use within atemperature range of 5 to 40°C (41 to 104°F) and within a humidity range of 35 to 80%.

Securely connect the power cord, computer 1/0O cable and so on so that they will not be unplugged and cause
failure during operation. Doing so may lead to faulty operation or breakdown.

* Do not place any object within the area




1 Getting Ready

Connecting the AC Adapter and Power Cord

Connect in the order of the numbers shown in the figure.

Ctm
&9
AC adapter jack

AC adapter

=
il

Power cord

Connecting to the Computer

To connect the machine and the computer, you can use either a parallel cable (IEEE 1284-compliant) .
The parallel cableis sold separately. Use a cable suited to the configuration of the printer port on your computer.

NOTICE Makethe cable connections while the computer and the machine are switched off.

Amphenol 36-pin connector

CIEs
O meadcos oo,

Printer port




EGX-20 USER'S MANUAL

I Attaching the Adhesive Sheet

You use the included adhesive sheet to secure materia to engrave to the table on the EGX-20.
First you need to install the included adhesive sheet on the table.

NOTICE Be sure the unit isin View status when attaching the adhesive sheet.

Carriage

Press the power button on the EGX-20 to turn on the
power.
The carriage moves to the right edge and the table moves
to the front, the unit goesinto View status, and the Power
and View lightslight up.

Table

Peel off the protective paper from both sides of the
adhesive sheet.

Place the adhesive sheet on the table as shown in the
figure at right, press down on it from above, and secure it

in place so that it will not peel off. Table

adhesive sheet

Adhesive sheet There are holes at the four corners of the table.
Align the corner of the adhesive sheet with the lower-left

hole.

10



1 Getting Ready

Installing the Cutter Holder

Before you install a cutter, you need to install the included cutter holder on the spindle unit.

A cutter holder is attached to the included cutter. P— )
Remove the cutter from the cutter holder.

Cutter Cutter holder

Open the cover for the carriage. — Open the cover for the carriage.

=
| ‘ [ i
o/ 2
Orient the cutter holder so that the screw is underneath, The cutter holder is reverse-threaded.
insert the cutter holder into the spindle unit from above, Turn it counterclockwise to tighten.

then turn the cutter holder counterclockwise by hand to
secureit in place.

The spindle unit moves when you do this, so insert the
included hexagonal screwdriver into the holein the
spindle unit as shown in the figure to keep it from
moving.

11



EGX-20 USER'S MANUAL

Installing and Setting Up the Software

To use the EGX-20, you need to install the driver on the computer connected to the EGX-20.
The EGX-20 also comes with a number of programs for creating engraving and cutting data, which you can use to match the target task.
To use these programs, you need to install and set them up on the computer connected to the EGX-20.

The Software You Can Install and Set Up

The drivers and programs are contained on the Roland Software Package CD-ROM.
Be sureto install aWindows driver.

Install and set up the other software, the programs, as required.

You can use the following drivers and programs with the EGX-20.

Driver or program

Overview

Windows driver

Thisis necessary when sending data from a program running under Windows to the EGX-20.
Besureto install it.

Virtual MODELA

This uses data created with 3D Engrave to perform simulations before cutting with the EGX-20.
You can use it to check the finished shape aswell as things like whether the cutting depth is suitable and how
much time cutting will take. This can reduce loss for cutting materials and time.

Dr. Engrave

Thisis used to design text and shapes to engrave on a plate and to send the data to the EGX-20.

You can use the TrueType fonts registered in Windows as the font style for text. You can even make stroke fonts
from TrueType fonts.

Because you can the outline of an image and convert it to line segments, it's also possible to include logos for
companies or organizations in the plates you make.

3D Engrave

This adds thickness to a flat (two-dimensional) graphic to create arelief (raised engraving).
You can also add thickness to figures and other images.

System

Requirements

The following operating environment is required in order to use the drivers and programs just described. Make sure your system
configuration meets these requirements.

Operating system

Windows 95/98/Me/NT 4.0/2000

Computer Computer running Windows (Pentium processor or better recommended)
Drive CD-ROM drive

Monitor Windows-compatible monitor capable of displaying 256 colors or more
Memory 32 MB or more recommended

Free hard-disk space

25 MB (combined total for Dr. Engrave, 3D Engrave, and Virtual MODELA)

required for installation

Interface

Printer port

Installation and Setup

NOTICE

If the computer and the EGX-20 are already connected, then switch off the power to the EGX-20 before you
perform installation and setup.

Installation and set up under Windows 2000/NT 4.0 require full access rights for the printer settings.
Log on to Windows as a member of the "Administrators" or "Power Users' group. For more information about
groups, refer to the documentation for Windows.

12



2 Getting Ready the Software

Follow the steps below to install and set up the driver and programs.

Turn on the computer and start Windows.

If you're running a virus-detection program, then quit the
program. Also quit all running programs except
Windows. In Windows, make sure no program icons
appear on the taskbar, then go on to the next step.

Insert the included CD-ROM into the CD-ROM drive.
The setup menu appears automatically.

If the setup menu does not appear automatically
even when the included CD-ROM isloaded in the
CD-ROM drive, then use Windows Explorer to
select the CD-ROM drive, then double-click
"CDMenu.exe" to runit.

Click the drop-down arrow for [Click here], then from

the menu that appears, select [EGX-20]. E=Roland Roland Software Package

Glick here. -

If your computer is connected to the Internet,
the Roland DG Corp. website appears.
Check this for information about updates to
the driver and the like.

Go to Rnla_nd DG Corporation Homepage

for PICZA, MODELA, CAMM-2, CAMM-3

Step1
Click the drop-down arrow for [Click
here] and choose the model name

Step 2
Click [Install].

Taview the description of a program,
click the [i] button. To view the manual,
click the [7] buttan.

{There are manuals in POF format for the
programs that the [7] button references.
Acrohat Reader is required fo view PDF
flles.)

The programs you can install and set up with the EGX-

20 appear. ==Roland Roland Software Package

You can view a description for each program by clicking
the (i) button next to the corresponding program name.
Also, to display the Readmefile, click the [Readme]
button. This lets you read the latest information that
could not be included in the user's manual. Please be sure
toread it before use.

S| Virtual MODELA a
® Dr.Engrave | h ae

™ 20 Engrave. : *ou can also add thickness toimages

& windows Driver

for PICZA, MODELA, CAMM-2, CAMM-3

Install

This adds thickness to a flat
({two-dimensional) graphic fo create a
three-dimensianal farm. |

such as illustrations.

If¥itual MODELA is installed and setup,
you can preview the shape after cutting

This document does not contain manuals for the programs, but amanual in PDF format is available for each

——| program shown with a[Z) button. Click the button to display the PDF manual.
Acrobat Reader isrequired to view PDF files. If Acrobat Reader is not already installed and set up on your
computer, then the setup program for Acrobat Reader on the included CD-ROM starts automatically, allowing you

toinstall and set it up.

13



EGX-20 USER'S MANUAL

You can choose to install and set up a program by
selecting its corresponding check box.

If you do not want to install a particular program, than
clear the corresponding check box.

Normally you should select all check boxes.

Click the [Install] button.

The setup screen ([Welcome] dialog box) appears for the
program whose check box you selected.

If you selected the check boxes for all programs, then the
setup screens appear in succession, starting with Virtual
MODELA.

Click [Next].

The[Select Install Location] dialog box appears.

If you want to change the folder to install to, then click
[Browse]. The [Select Directory] dialog box appears.
Choose a drive and folder, then click [OK].

Click [Next].

The [Select Program Folder] dialog box appears.
Thereis no specia need to change the program folder.
After you have made sure of the program folder, click
[Next].

Installation starts.

When installation finishes, a prompt dialog box appear.
Click [OK].

When the installation of one program finishes,
installation of the next one starts.

In theinterval until the next setup starts, a dialog box
showing the progress of processing is displayed.

x
==Roland Roland Software Package
for PICZA, MODELA, CAMM-2, CAMM-3 =

. virtual MVODELA

Step1
Click the drop-down arrow for [Click

& Dr.Engrave.
ke £ here] and choose the model name

& 3D Engrayve Step 2

& windows Driver Click [Install]

Taview the description of a program,
click the [i] button. To view the manual,
click the [7] buttan.

{There are manuals in POF format for the
programs that the [7] button references.
Acrohat Reader is required fo view PDF
flles.)

Rnla_nd DG Corporation Homepage

Melcome to the Virtual MODELA Setup
program.  This program will install

Virtual MODELA on your computer.

It is stronely recommended that wou exit all
Windows prozrams before running this Setup prozram.

Click Cancel to quit Setup and then close any
proerans wou have runnine. Click Next to continue
with the Setup prozram.

WARNING: This program is protected by copyright law
and intermational treaties.

Unauthorized reproduct ion or distribution of this
program, or any portion of it, may result in severs
civil and criminal penalties, and will be prosecuted
to the maximum extent possible under law.

Cancel

stination Location x|

Setup will install ¥irtual MODELA in the followineg
folder.
To install to this folder. click Next.

To install to a different folder, click Browse and
select another folder.

You can choose not to install Yirtual MODELA by
clicking Cancel to exit Setup.

Dest inat ion Folder
’VD:!!Prugram Files¥¥irtual MODELA Brouse...

< Back

Cancel |

Frogram Folder x

Setup will add program icons to the Program Folder
listed below. You may type a new folder name, or
select one from the existing Folders list. Click
Mext to cont inoe.

Existing Foldsrs:

ek B
ek b robat |
dobe Acrobat 4.0 [
Aladdin Expander 5.1J

AP 1 Twin

Capturs 1t !PRO

Dizital Media Park

Dvzate mot lon

Dvzste still |

< Back

[ bext > | Cancel |

@ Setup is complets. You may run the instslled program

14



2 Getting Ready the Software

The setup screen ([Welcome] dialog box) appears for the
next program to install.

Carry out steps( g ] through (9] on the previous page.
Install Dr. Engrave and 3D Engrave.

When installation of 3D Engrave finishes, the [EGX-20
Driver Installation] dialog box appears.

Choose the port for connecting the EGX-20.

The EGX-20 connects to a printer port. If your computer
has a single printer port, select [LPT1:].

Click [OK].

The EGX-20 driver isinstalled.

When installation of the EGX-20 driver finishes, the
[Settings: [EGX-20]] dialog box appears.
Make sure the values are correct, then click [Closg].

When all installation and setup finishes, a prompt dialog
box appears. Click [Closg].

When the setup menu screen reappears, click theil
button.

Take the CD-ROM out of the CD-ROM drive.

Port: LFTI

Timeoutfseconds) 3600

Eif per sevad I
Dt b I
Farity I

Stap bits
Felaw coritral

Tnstallation completed

5|

Complete.

Glose

==Roland Roland Software Package

for PICZA, MODELA, CAMM-2, CAMM-3

. Install

| virtual MODELA a

Step 1
[v | Dr.Engravg’ i Sy ﬂ Click the drop-down arrow for [Click

= 3D En rave.‘ 19
ol ﬂ . Step 2
[ windovis Driver a Click [Install]

To view the description of a program,
clickthe [i] hutton. Tao view the manual,
click the [?] hutton

(There are manuals in POF farmat for the
programs that the [?] button references
Acrohat Reader is required to view PDF
files)

Go to-Rpland DG Corporation Homepage

here] and choase the model name. I

15



EGX-20 USER'S MANUAL

Creat| N g a Nam ep I a.te (Operations in the Engraving Mode)

This section describes the basic steps for engraving using the EGX-20, taking the procedure for engraving the plate included
with the machine as an example.

" Loading Material

You use the included adhesive sheet to secure materia to engrave to the table on the EGX-20.

NOTICE Beforeyouload materia, attach the included adhesive sheet.
See-->p. 10 "Attaching the Adhesive Sheet"
Be surethe unitisin View status when loading material.

If the EGX-20 is switched off, press the power button to
turn it on. Power and View

The carriage moves to the right edge and the table moves lights lluminated
to the front, the unit goesinto View status, and the Power

and View lights light up.

If the EGX-20 isturned on but the View light is not

illuminated, press the View button.

The carriage moves to the right edge and the table moves

to the front, the unit goesinto View status, and the Power

and View lightslight up.

Place the plate on the adhesive sheet, then press down on
it from above to anchor it securely.
You can place the item anywhere on the adhesive sheet.
However, if the plate is placed at an angle with respect to
the table, the engraving will not be straight.
Place it so that it is aligned straight with the corners and

sides of thetable.

Place the plate on the adhesive sheet,
then press down on it from above to
anchor it securely.
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3 Creating a Nameplate (Operations in the Engraving Mode)

I Installing a Cutter

Move the spindle unit to above the plate (material) mounted on the table, then install a cutter.

If the View light on the switch panel islit (showing the
machineisin View status), press the View button.
The spindle unit and table move, and the spindle unit
moves to above the origin point on the table.

When movement ends, the View light goes dark.

Origin Point

The origin point is areference point that the EGX-20 uses for starting engraving. When the machine is shipped from
——| thefactory, the origin point is set at the lower Ieft corner of the table.
You can also move the spindle unit and the table and set the origin point at a different location.

See --> p. 19 "Setting the Origin Point"

Press up, down, or to the left

Use the movement button on the switch panel to move or right

the spindle unit.

The movement button is ajoystick.

Pressing the movement button up, down, or to the left or
right makes the spindle unit and table move in the
corresponding vertical or horizontal direction.

Move the spindle unit to about the center of the plate
(material) mounted on the table.

"%

ZAXIS =

Press and hold the center of the movement button for Press.
short while (0.6 second or longer). °

The Z-axis light illuminates, indicating that it is now [

possible to move the spindle unit up and down. 2 a8

Press the lower part of the movement button. The spindle
unit descends while you hold down the button.

Movement stops automatically when the depth regulator [.

nose contacts the plate (material), so release the 2@

movement button. \
Press.

Press the Origin Set button on the switch panel.
The spindle unit descends by 0.5 mm and the Origin Set
light lights up.

Depth regulator Press.

nose

17
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Insert the cutter into the hole in the cutter holder, then
slowly lower the cutter.
Lower until the cutter touches the plate.

NOTICE Beforeyouinstal acutter, install the cutter holder.
See --> p. 11 "Installing the Cutter Holder"

Use the included hexagonal screwdriver to tighten the
retaining screw for the cutter holder.

Tighten secure so that the cutter does not come |oose

during engraving.

Press the Origin Set button on the switch panel.
E The spindle unit rises 0.5 mm and the Origin Set light

goes dark.

18



3 Creating a Nameplate (Operations in the Engraving Mode)

I Setting the Origin Point

When loading material, be sure to set the origin point.
The origin point is the reference point for engraving. You set it individually for each piece of material you load.
Omitting this operation may result in locations other than the material being engraved.

Basic Steps for Moving the Spindle Unit

——| Whenyou installed the cutter in the spindle unit, you performed operations to move the spindle unit. These steps

can be summed up as follows.

The operation differs according to whether the View light and Z-axis light on the switch panel are illuminated or
dark.

Changing between the lighted View light (indicating View status) and dark View light
Press the View button on the switch panel.

When the View light isilluminated

You cannot move the spindle unit.

When the View light is dark

You can move the spindle unit using the movement button.

Changing between the lighted and dark Z-axis light

Press and hold the center of the movement button for a short while (0.6 second or more).
When the Z-axis light is illuminated

You can move the spindle unit up and down using the movement button.

When the Z-axislight is dark

You can move the spindle unit vertically or horizontally using the movement button.

Refer to the preceding "Basic Steps for Moving the
Spindle Unit" and move the spindle unit as follows. plate

1. If the cutter istouching the plate (material), move the
spindle unit upward to separate it lightly from the

material.

2. Movethe cutter to position it above the lower |eft
corner of the plate (material).

If the Z-axislight is dark, press and hold the Origin Set

button for a short while (0.3 second or more).

(Pressing the Origin Set button lights the Origin Set

Depth regulator nose portion of the spindle unit

light. Make sure the light is illuminated, then release the
button. The Origin Set light goes dark.)
The vertical and horizontal locations of the origin point

are set.

This completes the setting for the origin point.

Pressing the Origin Set button while the Z-axis light islit lowers the spindle unit and puts the machine in the state

——| forinstaling acutter.

When you are engraving a nameplate, there is no need to set a height-location origin point. The sensors
automatically detect the surface location of the plate (material).
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I Creating Data with Dr. Engrave

This section describes the basic steps for engraving a nameplate using Dr. Engrave.

=

The following explanation is for Windows 95/98/Me.
For an explanation for Windows NT 4.0/2000, or for amore detailed explanation, see the help for Dr. Engrave or
refer to the Dr. Engrave User's Manual (PDF) on the Roland Software Package CD-ROM.

Starting Dr. Engrave

In Windows, click the [Start] button. At the Start menu,
point to [Programs], then [Roland Dr. Engrave]. At the
menu that appears, click [Dr. Engrave].

Dr. Engrave starts.

E Foland Dr.Enerave

Specifying the Size of the Plate to Engrave

@ Dr.Engrave Help
f‘,ﬁ Dr.Engrave Uninstall

Dr Engrave

Make the size of the engraving area displayed by Dr. Engrave the same as the size of the actual plate to engrave.
Thisis analogous to choosing the form size in a word-processing program.

In Dr. Engrave, from the [File] menu, select [Print
Setup].

The [Print Setup] dialog box appears.

Make sure the printer name is set to [Roland EGX-20] (if
the printer name is not [Roland EGX-20], then click the
drop-down arrow and select [Roland EGX-20]), then
click [Properties].

The [Roland EGX-20 on LPT1: Properties] dialog box
appears.

Measure the size of the plate to engrave with aruler or
thelike, type in the values in the [Width] and [Length]
entry boxes, then click [OK].

The [Print Setup] dialog box appears again, then click
[OK].

The engraving areathat Dr. Engrave displaysis shown at
the size you specified.

Print Setup [21=]
— Printer
Marne: Froperties
Status: Ready
Type Roland EGX-20
“where: LPT1
Commeni t
— Pape: Orientation
Size: User Defined Size i = Portrait
Source 2 " Landscaps
e

Roland EGX-20 on LPT1: Properties

Size | Tool | Options |
Engravirg drea |
1524 =

idth :
Length:
Unit

= Millimeters
€ Inches

™ Boatate

About.

Cancel | sl
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3 Creating a Nameplate (Operations in the Engraving Mode)

Entering Text
Enter the text to engrave on the plate.

At the toolbar, click Al.

Click the location in the engraving area where you want
to type in text, then enter the text using the keyboard.

Engraving area

Selecting the Font

Specify afont for the text string you entered.

At the toolbar, click [A], then click the text string whose
font you want to change.

The character cursor appearsin the text string.
Alternatively, at the toolbar click k|, then click the text
string whose font you want to change.

Points appear around the text string.

From the [Format] menu, select [Font].

The [Font Select] dialog box appears.

Clicking afont name displays the text in the preview
field with the font you chose, alowing you to find the
font you want.

After you have selected the font you want, click [OK].

i@ Untitled - Dr.Enerave
File Edit Wiew Formst Shape Lavout Hep

T R E RS E N A =1 o o) g el T N W= A N

Cursor pos. [ 1277,04 Object center | 00,00 Dimension on, 00 Anzle |0 Slant [ 0 |
Ready | EC T

Character cursor Points

™\

Jean Jeam

Click a font name.

[eriat / oo

Frial] B

Arial Black 7 B _ Gorcel |
Arial Narrow |

Averida LET

Balloon

Balmoral LET

Bock Antiqus J ean
Bockman Old Styls =

Preview

——| See-->p.24"Stroke Fonts'

In the [Font Select] dialog box, font names that start with "Plot" are stroke fonts.
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Drag to make italic. /.

Working with Text Strings

You can resize and deform atext string by manipulating the points displayed around the string.

Resizing and Moving
At the toolbar, click ﬂ then click the text string.
Points appear around the text string.

You can change the size of the text string by lining up the
pointer with a point and dragging.

You can change the size while keeping the vertical/
horizontal aspect unchanged by holding down the [Shift]
key on the keyboard as you drag the point (ll).

You can move atext string by placing the pointer inside
the area bounded by the points and dragging.

Rotating Text, Italic Text, and Changing the
Character Pitch

When atext string is displayed with points, clicking the
text string changes the appearance of the points.

You can rotate atext string by lining up the pointer with
apoint (@) and dragging.

You can also make atext string italic, or change the
character or line pitch.

To hide points, click in the area outside the points.

You can change the size by dragging.

I/ \I

&

-
@ m T~ You can change the

horizontal size by
dragging.

You can change the vertical size

by dragging.

To move, place the pointer in the area inside
the points and drag.

Q@@m

./ Drag to rotate.

Jerl,

J“m \ Drag to Change the

text pitch.

David
Adams

.\
text strings, this point is displayed.
Drag it to change the line pitch.
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3 Creating a Nameplate (Operations in the Engraving Mode)

Text-string Settings

You can specify numerical value for rotation, slanting, character pitch, and so on in adialog box.

At the toolbar, click Al then click the text string.

The character cursor appears in the text string.
Alternatively, at the toolbar click ﬂ then click the text
string.

Points appear around the text string.

From the [Format] menu, select [Properties).

The [Text string Properties] dialog box appears. oG EIAERER
_ ] ) T 0
Changing the settings for any of the items updates the et W'I_: H J =
settings for the text shown in the preview field. wen BT = 2z You can change the
N . . . A:;’;— Z;iwn*‘waﬂ““' i |j LI character boldness.
When you have finished making the settings, click [OK]. Ohgrasler [—— e —
SDEE;:; [ Boldness Mormal 4 = * ' Bod
Golor T~
Jean Tv—.

Filling a Text String

If the Fill setting is not made, only the outlines of characters are engraved.
When the Fill setting is made, the interiors of characters are all engraved by flat-dragging.

At the toolbar, click Al then click the text string.

The character cursor appears in the text string.

Alternatively, at the toolbar click ﬂ then click the text

string.

Points appear around the text string. When you click this to select the check

box, flat-drag engraving of the interiors of

. the character outlines is performed, then
At the toolbar, click ' the contour lines of the characters are

Alternatively, from the [Shape] menu, select [Fill]. engraved.

The [Fill Setup] dialog box appears.

Click [Fill] to select the check box. © Eil 7 5]
[Fitch] isthe engraving spacing of the cutter. L Cancel

When you're using the included cutter, set thisto [0.1].

\ You can specify colors and vary the

When you have finished making the settings, click [OK]. engraving depth for each color

Pitch lines appear in the characters.
The cutter moves along theselines as it engraves.

The spacing of these
lines is the pitch.

L

Enlarged area /

Click 2/ on the toolbar to make the
pointer change to Q then click the

location where you want to zoom in.
Right-click to zoom out.
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-]

SN

-]

@) [

=)

Stroke Fonts

You can change text to stroke fonts and carry out engraving.
Line width when engraving varies according to the cutter width and engraving depth.

At the toolbar, click ﬂ, then click the text string.

The character cursor appears in the text string.
Alternatively, at the toolbar click ﬂ then click the text
string.

Points appear around the text string.

At the toolbar, click D).
Alternatively, from the [Format] menu, select [Make

Stroke].

The [Select Stroke Font] dialog box appears. Ssleot Stioke Font

Click the drop-down arrow to display the menu, then Sirake Font Name [ ok |

select astroke font. o = Cancel
“FEio fre

After you have selected the font you want, click [OK]. 50 G .

Jed

Stroke font

"Plot."
See --> p. 21 " Selecting the Font"

% In the [Font Select] dialog box aswell, you can specify a stroke font by selecting afont whose name starts with

Converting to Polygons

You can convert text strings to graphic shapes (polygons). This makesit possible for you to modify the shape of characters, to

create logos, for example.

At the toolbar, click ﬂ then click the text string.

The character cursor appearsin the text string.
Alternatively, at the toolbar click &, then click the text
string.

Points appear around the text string.

From the [ Shape] menu, select [Convert to Polygon].
Thetext string is convert to a shape.

When the text string is displayed with points, clicking ]
on the toolbar displays points at the vertices of the
polygon.

Alternatively, click E on the toolbar, then click the
polygon. Points appear at the vertices of the polygon.

You can change the shape by dragging the points.
You can a'so insert and cut away vertices by moving the

pointer to aline or point and right-clicking. d E a m

Example of Converting a
Stroke Font to a Polygon

Inzert Vertex s
Delete Wertex Def
(Gonrest Veriex: At
Sever Wertex  Alt+Del
Siap o Vertex

Properties Alt+Enter

This menu appears when you
move the pointer to a line or
point, then right-click.




3 Creating a Nameplate (Operations in the Engraving Mode)

The [SaveAs] dialog box appears.

Saving Data

Save the data you have created to a hard disk or the like.

At the toolbar, click &|.
Alternatively, go to the [File] menu and select [Save As).

Specify the information for [Save in] and [File Namg], = oo = [=

My Pictures

then click [Save].

File name: [N Save |
Save aslype: [DrEngrave Document - ded) =] Cancel

2|

I Setting the Cutting Parameters

Before you carry out engraving, adjust the Speed control and Spindle Speed control on the switch panel of the EGX-20.
When you're performing engraving for the first time, set the Speed control at the central
position and the Spindle Speed control at its maximum setting.

Also, if you're using acrylic material and the included blade, then you may leave the
settings for the EGX-20 driver at their default values.

Go ahead and try engraving using these settings.
In some cases it may not be possible to perform engraving smoothly. In such cases,
examine the engraving results and adjust the settings for the cutting parameters, repeating
this process of trial and adjustment until you obtain good engraving results.

o
ZAXIS

| Atthe central position

00

At maximum
/

o

o

elolele)

General Suggestions for Making Adjustments

Depending on the engraving results, make the settings as described below. Use the Speed control and the Spindle Speed control to make
the adjustments.

If engraved places are rough (not smooth), then lower the speed.

If the material melts or suffers burring, lower the spindle speed.

If the spindle speed is too fast, the material may melt. Lower the spindle speed.

Also, if thereis buildup of melted cuttings in engraved grooves, you may be able to remove them by scrubbing with a toothbrush or
thelike.

Increasing the spindle speed when using a narrower blade and reducing it when using athicker blade may produce better results.

In many cases, slower speeds produce attractive finished results, but a speed that is too slow may cause melting.

Make the following adjustments with the driver.

The default engraving depth is 0.1 mm. You can engrave at a greater depth by changing the value for the driver setting [Z Down

Position]. The maximum depth at which you can engrave is 1.0 mm. (In the driver, you make the setting by specifying avaue

prefixed by aminussign ["-"].) A greater engraving depth yields correspondingly wider lines. This means that text characters also

become thicker.

If the engraving depth istoo deep, it may not be possible to obtain attractive results even when the speed and spindle speed are

adjusted.

One method for obtaining engraving results that are attractive yet deep isto perform the same engraving twice.

(For example, setting [Z Down Position] to -0.18 mm and [Z Engraving Pitch] to 0.10 mm and performing the same engraving twice

resultsin engraving at adepth of 0.18 mm.)

Leave [Z Up Position] set to 0.50 mm at all times. Lower values result in less wasted movement.

You can obtain attractive engraving results by setting [Fill Pitch] to 80% or less than the width of the cutter -- actually at about 50%.
See -->p. 23 "Filling a Text String"
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Adjusting the Driver Settings

Follow the steps below to set the cutting parameters for the driver.

. In Dr. Engrave, from the [File] menu, select [Print
1 Setup].

The [Print Setup] dialog box appears. EIESE [E1=]
Make sure the printer name is set to [Roland EGX-20] (if [ — —
the printer name is not [Roland EGX-20], then click the Sebw  Fes
drop-down arrow and select [Roland EGX-20]), then i el
click [Properties]. Fomment

-~ Paper Orientstion
Size: User Defined Size - n  Partrait
S ® L
Cancel |
The [Roland EGX-20 on LPT1: Properties] dialog box
3 appears.
Click the [Tool] tab.
The[Tool] page appears. Roland EGX-20 on LPT1: Properties HE
4 Change the values for items that need to be adjusted, Sie '””‘I el =
. Material : [Acryl -
thenC“Ck[OK]' [P [ [ | O [ [
CIRRT 3| DR S el el Al
Lok 1 3]
Engraving Conditions
HY Speed Z Speed
15 :.' [mmés] 2 :.' [rnds]
¥ il 2Z Up Pasition
Fill Fitch z
CE ZD[?SWEPDZI:iu[;M]
010 :ll -
Z Engiaving Pitch
Defauit 070 2] fom)

Comments

0k | Coneel Bl

Clicking 2| at the upper right of the dialog box changes the pointer to [ , which you can then use to click an
——| itemyou want to learn about in detail. A detailed explanation appears.

To return to the [Print Setup] dialog box, click [OK].
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3 Creating a Nameplate (Operations in the Engraving Mode)

I Performing Engraving

Now Let'stry engraving a name on a plate.
If the View light on the EGX-20 isilluminated, press the View button to make the View light go dark.

At the toolbar, click 2],
Alternatively, go to the [File] menu and select [Print].

The [Print Setup] dialog box appears.

Make sure the printer name is set to [Roland EGX-20] (if the printer name is not [Roland EGX-20], then click the drop-down
arrow and select [Roland EGX-20]), then click [OK].

Cutting starts.

When engraving ends, the spindle unit rises all the way to the top and stops there.
Then, remove the material, press the View button.
The carriage moves to the right edge and the table moves to the front, allowing you to detach the material from the adhesive

sheet.

Use atoothbrush or the like to carefully brush away any buildup of cuttings on the material or the adhesive sheet.
Also, use avacuum cleaner to carefully clean away any cuttings remaining on the EGX-20.

Emergency Stop

If some problem occurs while engraving isin progress and you want to stop the EGX-20, follow the steps below.

Press the power button on the switch panel.

If there is a printer icon on the taskbar in Windows, double-click the icon.
The progress of printing is displayed. Delete the document.
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The 3D Cutting mode

To cut thick material and produce arelief or the like, the EGX-20 must be in the 3D Cutting mode.
To enable the 3D Cutting mode, first detach the depth regulator unit from the spindle unit.

" Removing the Cutter

If acutter isinstalled, then remove the cutter first.

Open the cover for the carriage.

Use the included hexagonal screwdriver to loosen the
retaining screw for the cutter holder.

such away that it can be loosened but not

% The screw is attached to the cutter holder in
—  detached completely.

Grasp the top of the cutter and pull it up and out.
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4 The 3D Cutting mode

" Detaching the Depth Regulator Unit

If the EGX-20 is switched off, press the power button to
turnit on.

The carriage moves to the right edge and the table moves
to the front, the unit goesinto View status, and the Power
and View lightslight up.

If the EGX-20 isturned on but the View light is not
illuminated, press the View button.

The carriage moves to the right edge and the table moves
to the front, the unit goesinto View status, and the Power
and View lightslight up.

Press the power button to switch off the power.

Open the cover for the carriage.

The depth regulator unit is secured in place by two
screws.

Use the included small hexagonal wrench to loosen the
two screws.

When you do this, support the depth regulator unit with
your hand to keep it from falling.

After loosening the two screws, move the depth regulator
unit downward and detach it from the spindle unit.

Store the depth regulator unit in a safe place
——| toguard against losing it.

Power and View
lights illuminated

Open the cover for the carriage.

Screw

e
— <2 Sy

I
)

When you switch on the EGX-20, a sensor checks whether the depth regulator unit isinstalled. At thistime, the

——| machine goesinto the Engraving mode if the depth regulator unit isinstall and the 3D Cutting mode if it is not

installed.
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I Installing a Cutter

In the 3D Cutting mode, you install a cutter before you load material.

Press the power button to turn on the power.

The carriage moves to the right edge and the table moves
to the front, the unit goesinto View status, and the Power
and View lights light up.

-]

Pressthe View button.

The spindle unit and table move, and the spindle unit
moves to above the origin point on the table.

When movement ends, the View light goes dark.

)

Use the movement button on the switch panel to move o .®
the spindle unit to about the center of the table. [ Gj @ Press up, down, or to the left or right.

)

NeY
ZAXIS &

Press and hold the center of the movement button for a

Press.
short while (0.6 second or more). ® —
The Z-axis light illuminates, indicating that it is now

possible to move the spindle unit up and down. e

=)

Press the lower part of the movement button. The spindle

(]

unit descends while you hold down the button. Hold o Press
down the movement button until the spindle unit stops [ @ —
automatically. zS

mm

The spindle unit stops, leaving a small gap.

@’!
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4 The 3D Cutting mode

Insert the cutter into the hole in the cutter holder, then Use the included hexagonal wrench to tighten the
slowly lower the cutter. 7 retaining screw for the cutter holder and secure the cutter
Lower it until the cutter touches the adhesive sheet. in place.

=

" Loading Material

You use the included adhesive sheet to secure material to engrave to the table on the EGX-20.

NOTICE Before you load material, attach the included adhesive sheet.
See --> p. 10 "Attaching the Adhesive Sheet"
Be sure the unit isin View status when loading material.

If the View light is dark, then press the View button.

The carriage moves to the right edge and the table moves
to the front, the unit goesinto View status, and the Power
and View lightslight up.

Place a piece of material on the adhesive sheet, then
press down on it from above to anchor it securely.

You can place the item anywhere on the adhesive sheet.

However, if the plate is placed at an angle with respect to

the table, the engraving will not be straight.

Place it so that it is aligned straight with the corners and
sides of the table.

Place the plate on the adhesive sheet, then press down
on it from above to anchor it securely.
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I Setting the Origin Point

When loading material or installing a cutter, be sure to set the origin point.

The origin point is the reference point for engraving. You set it individually for each piece of material you load.

In the 3D Cutting mode, you separately set the origin point for the vertical and horizontal position of the material and the origin
point for the height (thickness).

Omitting this operation may result in locations other than the material being engraved.

Setting the Height Origin Point

Refer to "Basic Steps for Moving the Spindle Unit" on

page 19 and move the spindle unit as described below.

1. Move the spindle unit to position it at the center of the
material.

2. Movethe spindle unit downward until the cutter is
nearly touching the surface of the material.

In the 3D Cutting mode, the cutter rotates when you lower the spindle unit. Lowering the cutter until it touches the
material resultsin the material being cut. Stop it at alocation where it does not quite make contact.

L oosen the retaining screw for the cutter holder and )‘
move the cutter until it touches the material. =
When the cutter is touching the material, tighten the
retaining screw for the cutter holder to secure the cutter
in place.

Make sure the Z-axis light on the switch panel is
illuminated, then press and hold the Origin Set button for
ashort while (0.3 second or more).

(Pressing the Origin Set button lights the Origin Set
light. Make sure the light is illuminated, then release the
button. The Origin Set light goes dark.)

Loosen the retaining screw for the cutter holder and move the cutter
until it touches the material.

You can set the height origin point by pressing the Origin Set button when the Z-axis light isilluminated.
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4 The 3D Cutting mode

Setting the Origin Point for the Vertical and Horizontal Position

Refer to "Basic Steps for Moving the Spindle Unit" on material
page 19 and move the spindle unit so that the cutter is
positioned above the lower left corner of the material.
Lower the spindle unit to check whether the cutter is at
the lower left corner.

AN

Move the cutter to this location.
If the Z-axis light on the switch panel isilluminated,
press and hold the center of the movement button for a
short while (0.6 second or more).
Make sure the Z-axis light is dark, then press and hold
the Origin Set button for a short while (0.3 second or
more).
(Pressing the Origin Set button lights the Origin Set
light. Make sure the light is illuminated, then release the
button. The Origin Set light goes dark.)

You can set the origin point for the vertical and horizontal position by pressing the Origin Set button when the Z-
——| axislightisdark.
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I Creating Data with 3D Engrave

This section describes the basic steps for cutting arelief using 3D Engrave.
3D Engraveis aprogram for adding thicknessto aflat (two-dimensional) graphic to create arelief (raised engraving).
You can a'so add thickness to figures and other images.

=

Starting 3D Engrave

The following explanation is for Windows 95/98/Me.
For an explanation for Windows NT 4.0/2000, or for a more detailed explanation, see the help for 3D Engrave or
refer to the 3D Engrave User's Manual (PDF) on the Roland Software Package CD-ROM.

In Windows, click the [Start] button. At the Start menu,
point to [Programs], then to [Roland 3D Engrave]. At the
menu that appears, click [3D Engrave].

3D Engrave starts.

E Foland 30 Enerave

@ 3D Engrave Help
@ 3D Engrave Uninstall

Selecting the Driver

Select the output device (driver).
Even if you click [Properties] and make sets for the size of the material or the cutting conditions (tool speed, depth, and so on),
the data that is output is not affected.

In 3D Engrave, go to the [File] menu and select [Output
Device Setup].

The [Print Setup] dialog box appears. T HE
Make sure the printer name is set to [Roland EGX-20] (if o —
the printer name is not [Roland EGX-20], then click the Status:  Feads
drop-down arrow and select [Roland EGX-20]), then I
click [OK]. commen
Size: User Defined Size i I & Portrait
Soucs [ ] ® Lt
cancel |
Selecting the Model
Select the model name.
This generates a tool path matched to the selected model.
In 3D Engrave, go to the [Cut] menu and choose
[Machines].

The [Model Selection] dialog box appears.
Select [EGX-20], then click [OK].

MDR-15 (MODELA,
MDi=-20 (MODELA)
MDi=-3 (MODELA

MDX-500 30
MDH-500 (RML-1)
FNC-2300 [CAMM-2)
Library Version 1.00

=

Gance|

]
|

Information

Ielancimum
Cutting Area

Model Selection x|

Width 2032 mm
Length 1624 mm
Height 70 mm

Mavement
Speed Range

Ky 01 - 160 mm/s
Z:01 - 80 mm/z
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4 The 3D Cutting mode

Specifying the Size of the Relief

In 3D Engrave, go to the [Relief] menu and select [Relief Therelief areais displayed. Therelief areaiswhere you
Size]. design therelief.
The screen displayed at thistimeis called the"2D
screen.” It's the screen for typing in text and creating

. The[Relief Size] dialog box appears. shapes.
2 For Size, typein the size values for the relief in the & Ut D
[Vertical] and [Horizontal] entry boxes, and in EEME Tl o g

[Resolution], enter the degree of detail. Then click [OK]. DENIPEP mﬂﬁ%ﬁ”
Alo|c=E=] *Es =] o ml=lE] [ e mEE = 13

Resolution 12 mm

e e
Relief area of the 2D screen — R:ZMW Genterpaint | Dimension ’7"1;;0 %\ An’gli ’yTTM j
Shape-drawing buttons
Creating Shapes and Text /
Unlitled - 3DEngrave/ = -]

To create shapes and text, you click the shape-drawing buttons and Ele Bt Mew Ipcee Shape Reiel v Heb
drag in the relief area. T 5 = 5 S S DA R
To typein text, click the /A| button, then click inside the relief Y (51100 5 ) g e 0 9 Y

area. When the character cursor appears, type in the text from the
keyboard.

To change the size of shapes or text, refer to "Working with Text
Strings' on page 22.

Gursor | 1693,38 Centerpaint | Dimension mm | Anele sl

Ready ioo% | NUM

Creating a Raised Engraving (Relief)

Add thickness to shapes and text to create arelief.

Click the shape or text string you want for adding The shape of the relief is displayed as athree-
thickness to select it. dimensional solid.

Thiswindow is called the "3D screen.” It displays the

N ()

Click the g button. shape of the relief and the tool path. You cannot edit
The [Create Relief] dialog box appears. shapes or text.
The dialog box may differ depending on the type of B U Bl

object you selected. The window shown below is the b ER Wap bem Erp E @ [
dialog box that appears when you are creating a shape or ] 2 =T R T Y X DA T
text. e T e e et = e e

Make the settings for the items required to creste the
relief, then click [OK].

Bisttom Surface [ or ]
Heieht 11 mm o
Felet - _ ozl |
Rice fingle 5 o Aln|AlA o
i
Direstion P e i
o | .
*
W Smoothing BT The maximum Dursor| 1885280 Centerpoint | Dimension mm | fnele sl

cutting height is 7 mm. Ready [ (A% [ [NOM s
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Generating the Tool Path

A tool path is the path followed by the tool's blade tip.

Thetool path is generated from the cutting parameters that are presently set.

Before you create the tool path, make the settings for the cutting parameters.

At the cutting parameters, make the settings for the composition of the workpiece, the type of tool, and the cutting process.

1 From the [Cut] menu, select [Cutting Parameters]. Cuttine Parameters
The [Cutting Parameters] dialog box appears. o beny
H H . i [a mm Cancel
Make the settings for the necessary items for cutting, o e
then click [OK] . ( @ Draft Cultine Finishing for Eneraving! |
=
Type
yP(‘ Square End Ml vl e
" Ball End Mill Blads Width |0.25 mm
& Engraving Tool Blade Angle A0 | deg
~Garving Gondit
ImeFri(:\ 218 mim Spa)é\; 127 mm/zec
OWtneh GO mm  zSpeed [T mm/oec
J;’r'gﬁ (] i Spirel= [EOD. 0 | R
* The blade angle of the general-use cutter is [30] degrees.
* |f you're using a flat cutter, select [Square end mill].
2 Click the Q button. When the tool path is created, it CYTCEEECI—
L File Edt Vow Inae Shape Belef Gut belo
appearsin pink on the 3D screen.

nlz(m| | (o] ofw a[uluul

s o e e > e o =

Gursor 1413 285 Centerpaint | Dimension mm ‘ Angle al
Ready (%[ NOM

Draft Cutting and Finishing

Cutting has two processes: draft cutting and finishing. You first create the tool path for draft cutting and carry out cutting. After
draft cutting ends, go back to this step, create the tool path for finishing and perform cutting again.

Be sure never to perform finishing on material that has not undergone draft cutting.

Checking the Cutting Results

If Virtual MODELA isinstalled and set up, then before you perform cutting you can check the shape that will be produced after
cutting on the screen.

From the [File] menu, choose [Output Preview].
Virtual MODELA starts.

The 3D Engrave cutting datais imported into Virtual = S Qo Vi)
2 MODELA. o = | P R T
_—

An animated display of tool movement appears, and the
shape after cutting is gradually produced.

Ready [1x  [«2613 w5160, z-40778 (025
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4 The 3D Cutting mode

Saving Data

Save the data you have created to a hard disk or the like.

At the toolbar, click E
Alternatively, go to the [File] menu and select [Save Ag).

The[SaveAs] dialog box appears.
Specify the information for [Save in] and [File Name],

then click [Save].

1 Adjusting Cutting

Before you carry out engraving, adjust the Speed control and Spindle Speed control on the switch panel of the EGX-20.

When you're performing cutting for the first time, set the Speed control at the central J—
position and the Spindle Speed control at its maximum setting. [o

At the central position

Also, 3D cutting may use materials such as modeling wax that differ from the material

used for nameplate engraving. In such casesit may also be necessary to change the cutter @
to match the composition of the material.
You need to set cutting parameters that match such changes in the material and the cutter. @/ At maximum
First, test cutting using a small relief.

If smooth cutting is not possible, then adjust the settings for the cutting parameters.
Repeat this process until smooth cutting is achieved.

SPEED

O

O

o

5
©
)

—

®

General Suggestions for Making Adjustments

Depending on the cutting results, make the settings as described below. Use the Speed control and the Spindle Speed control to make the
adjustments.

« If cut places are rough (not smooth), then lower the speed.
« If the material melts or suffers burring, lower the spindle speed.
« If the spindle speed istoo fast, the material may melt. Lower the spindle speed.

Also, if thereis buildup of melted cuttings in engraved grooves, you may be able to remove them by scrubbing with a toothbrush or the
like.

« Increasing the spindle speed when using a narrower cutter and reducing it when using a thicker cutter may produce better results.
 In many cases, slower speeds produce attractive finished results, but a speed that istoo slow may cause melting.
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I Performing Cutting

Now let'stry cutting arelief.
If the View light on the EGX-20 isilluminated, press the View button to make the View light go dark.

At the toolbar, click @
Alternatively, go to the [File] menu and select [Output].

. A dialog box with the prompt " Start cutting." appears.
2 Click [OK] & Start cutting.

Cutting starts. 5
. When cutting ends, the spindle unit rises al the way to
3 the top and stops at that position.

If you carried out draft cutting, then go back to
"Generating the Tool Path" on page 36 and perform
finishing. Be sure not to remove the material at thistime.

When finishing cutting ends, remove the material.
Pressing the View button moves the carriage to the right
edge and moves the table to the front, allowing you to
detach the material from the adhesive sheet.

Use atoothbrush or the like to carefully brush away any
buildup of cuttings on the material or the adhesive sheet.
Also, use avacuum cleaner to carefully clean away any

cuttings remaining on the EGX-20.

Emergency Stop

If some problem occurs while cutting isin progress and you want to stop the EGX-20, follow the steps below.
Press the power button on the switch panel.

If thereis a printer icon on the taskbar in Windows,
double-click theicon.

The progress of printing is displayed. Delete the
document.

N ()
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5 Important Notes, Limitations, and Other Information

Important Notes, Limitations, and Other Information

I Important Notes and Limitations

O The depth regulator nose cannot overcome a difference in level.
* When you load more than one plate at atime, make sure there are no gaps between them.

« Platesthat are not quadrilateral or are of irregular shape may not be suitable for engraving with the EGX-20.

QO Fill engraving over a broad area is not possible.
« Processing such as performing afill operation over the entire surface of alarge plate to cut raised characters cannot be performed in

the Engraving mode. This is because the depth regulator nose drops below the differencein levels.
When you want to perform afill operation over awidth that is broader than the diameter of the depth regulator nose, use the 3D
Cutting mode.
Note, however, that in the 3D Cutting mode, line width is not uniform unless considerable care is taken to ensure a constant cutting
depth, and so it may be impossible to obtain attractive engraving results. Thisis because the depth regulator noseis not used in the
3D Cutting mode, so there is more variation in cutting depth from one location to another.

O Using different depth regulator noses for different purposes

¢ The machine comes with two types of depth regulator noses, one large in size and one small, but normally you use the medium-size
depth regulator nose installed in the depth regulator unit.
In cases like those described below, change the depth regulator nose.

- Use the large-size one when characters are relatively large and the fill width is broad.

- Use the small-size one when you are engraving a surface with arelatively large curve, such asacylindrical object.

Changing the Depth Regulator Nose
The depth regulator nose isinstalled in the depth regulator unit. To changeit, first detach the depth regulator unit.

To Detach

Turn the depth regulator nose counterclockwise
to line up the notches on the depth regulator unit
with the tabs on the depth regulator nose,
allowing you to pull out the depth regulator nose.

Open the cover for the carriage.

To Install

Orient the depth regulator nose so that the two
tabs face up, then insert it into the depth
regulator unit from below.

Line up the tabs on the depth regulator nose with
the notches on the depth regulator unit, insert,
then turn the depth regulator nose clockwise to
secureit in place.

Depth regulator unit

notches

tads
Depth regulator nose
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O The depth regulator unit is affected by changes in temperature.
« A sensor on the depth regulator unit detects the surface of the plate being engraved, but large changes in temperature may ater the
depth. Use care when using near an air conditioner or heater.
In caseslike this, reinstall the cutter (thereby realigning it with the reference surface).

O Feature for Specifying a Number of Different Cutting Parameters
Dr. Engrave lets you specify up to eight different colors for the lines that are drawn, and the driver lets you set different sets of cutting
parameters for each color. With the defaults, black isthe driver'sfirst setting and red is the second. Using this lets you do things like
giving black text a depth of 0.1 mm and red text a depth of 0.08 mm.

O Maximum Cutting Depth
Thisisup to 1 mm in the Engraving mode and up to 7 mm in the 3D Cutting mode. Do not attempt cutting that exceeds these depths.

B Functions Using the Switch Panel on the EGX-20

In addition to the usual operations using the switch panel, you can a so use the switch panel to carry out operations like the ones
described below.
Carry out the following operations with the power to the EGX-20 switched off and the EGX-20 disconnected from the AC adapter.

Displaying the Working Time of the Spindle Motor

During normal operation, if the Z-axis light flashes slowly for ten seconds (four or five flashes) when you turn on the power, it means the
spindle motor has been powered up for over 1,000 hours.
The spindle motor is a consumable part. As a general guide, we recommend replacing it after every 1,000 hours.
You can also use the following procedure to check the number of hours that the spindle motor has been powered.
1. While holding down the View button on the switch panel, insert the AC adapter into the EGX-20.
The illumination and flashing of the Z-axis light, Power light, View light, and Origin Set light show how many hours the unit has
been powered up.

Less than 250 hours  Less than 500 hours  Less than 750 hours Less than 1,000 hours 1,000 hours or more

Z-axis light ° ° ° ° O Slow flashing
Power light - - - ° °
View light - - ° ° °
Origin Set light - ° ° ° °
e :llluminated —:Dark O :Flashing

2. After you have verified the time, press the View button. This switched off the power.

Resetting the Working Time of the Spindle Motor

When you have replaced the spindle motor with a new motor, follow the steps below.
» While holding down the power and View buttons on the switch panel, insert the AC adapter into the EGX-20.
The View light illuminates and the powered time of the spindle motor is reset.
Setting the Origin Point to Its Default Value (the Lower Left Corner)
* While holding down the Origin Set button on the switch panel, insert the AC adapter into the EGX-20.
The Origin Set light illuminates and the origin point is set to its default (at the lower left corner).
Setting the Origin Point at the Center of the Table

« While holding down the center of the movement button on the switch panel, insert the AC adapter into the EGX-20.
The Z-axis light illuminates and the origin point is set at the center of the table.
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6 Other Information

Other Information

1 Replacement Cutters and Consumable Parts

The following replacement blades and consumable parts are available.

Replacement Cutters (Diameter 3.175 mm and Length 114 mm)

O General-purpose (general-purpose cutters suitable for engraving acrylic and plastic plates)

No. Blade width
* ZEC-A2013 0.127 mm
* ZEC-A2025 0.254 mm (* Thisisthe originally included blade.)
* ZEC-A2051 0.508 mm
* ZEC-A2076 0.762 mm

QO Flat cutter (blades having a wider tip than general-purpose cutters)

No. Blade width
« ZEC-A2150 1.52 mm
¢ ZEC-A2190 1.91 mm
¢ ZEC-A2230 2.29 mm
« ZEC-A2320 3.175mm

O Quarter-round types (having a larger tip pocket than general-purpose cutters, and suited to
engraving soft material at high speed)
No. Blade width
*« ZEC-A2013-QR 0.13 mm
*« ZEC-A2025-QR 0.25 mm

Adhesive Sheet

No. Specification
*AS-10 210 mm x 140 mm, 10 sheets

Replacement Spindle-motor Unit

Asageneral guide, we recommend replacing this after every 1,000 hours.

1 Daily Care and Maintenance

» Use avacuum cleaner to carefully clean away cutting dust.

» Use atoothbrush or the like to remove cuttings from the adhesive sheet.

Do not use an air blower or the like to blow away cutting dust. The cuttings may get inside the machine and cause breakdown.

» Use adry or well wrung-out cloth to wipe clean. Do not use solvents such as thinner or acohol.

* Lubrication is not required. Improper application of grease or the like may actually lead to breakdown and should not be attempted.
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" What to Do If...

O The power switch doesn't turn on the power.
—> Disconnect the AC adapter from the machine, reconnect it, then turn on the power.

O The power switch doesn't turn off the power.
—> Disconnect the AC adapter from the machine.

O The power light flashes every 0.25 seconds, and the machine operations strangely or not at all.

—> |ncorrect data has been sent. Check whether an incorrect printer driver has been selected. Also check for faulty cable connections and
thelike.

O The power light flashes once a second and the machine stops.

—> Theload is excessive. You can resume operation by pressing the View button, but if operation stops again, make the cutting parameters
less demanding, such as by using a slower speed. If the problem occurs frequently, the cutter or the spindle motor may have reached
the end of their service life.

O The Z-axis light flashes for ten seconds.

—> The usage time of the spindle motor has exceeded 1,000 hours. The spindle motor is a consumable part. As ageneral guide, we
recommend replacing it after every 1,000 hours. Be sure to replace the motor if it seems to be running poorly.

QO All the lights flash and the machine doesn't operate.
—> Disconnect the AC adapter from the machine, reconnect it, then turn on the power.

O The depth gradually changes during engraving.

—> This can be caused by large changes in temperature due to a heater or the like. Wait for the temperature to stabilize, then reinstall the
blade.

QO The depth is uneven or unattractive.

—> Theinstalled cutter may be loose. Tighten securely using the hexagonal screwdriver. Also tighten the cutter holder securely. (The
cutter holder isreverse-threaded, so turn counterclockwise to tighten.)

O The actual depth is completely different from the set depth.

—> |sthe depth regulator unit installed? Was installation or removal of the depth regulator unit carried out with the power off? When you
turn on the power after installing or removing the depth regulator unit, the machine automatically changes to the Engraving mode or
the 3D Cutting mode.

O A screeching sound is heard and engraving takes place at a strange location or is misaligned.

—> The machine lost its positioning, possibly because the material became caught on something. Reset the power and redo the operation
from the beginning. The depth regulator nose cannot go beyond differencesin level, so go into [Print Setup] and set the cutting areato
asuitable value to prevent movement beyond the edges of the plate.

—> |t is possible that excessive buildup of cuttings has occurred, and some cuttings have gotten inside the machine. Cleaning thoroughly
using avacuum cleaner or the like. Cleaning should be performed carefully.

—> |f the problem persists, a breakdown may have occurred. Contact your authorized Roland DG Corp. dealer or service center.

O No engraving is performed when data is sent from the computer.
—> |f the View light isilluminated, it means that operation is paused. Press the View button to release it.
—> The origin point is too far toward the back or right side of the table. Set the origin point again.

O The spindle motor does not turn.

—>|n The [Roland EGX-20 on LPT1: Properties] dialog box, on the [Options] page, thereis a setting called [Engrave with spindle motor
stopped]. Check this.

—> Applying lubrication may lead to buildup of cuttings that then hardens. Clean away using a brush or the like.
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—> The spindle motor may have reached the end of its service life. The spindle motor is a consumable part. As ageneral guide, we
recommend replacing it after every 1,000 hours.

QO Part of the carriage strikes the material while in the 3D Cutting mode.
—> The maximum cutting depth when in the 3D Cutting mode is 7 mm. Check whether you are attempting to create arelief larger than

this.

O The cutter holder cannot be removed.
—> The cutter holder is reverse-threaded. Turn it clockwise to removeit.

I Specifications

Main Unit Specifications

Tablesize

Table load weight
Carriage cutting range
Carriage operating speed

Cutting-depth control
Maximum cutting depth

Cuttable material

Resolution

Spindle motor

Spindle rotating speed
Overload detection feature
Cutter diameter

Interface

Buttons and controls

Indicators
Power supply

Power consumption
Operating noise level

External dimensions
Machine weight

Package external dimensions
Package weight

Operating environment

Included items and accessories

220 (W) x 170 (D) mm (8-5/8 (W) x 6-11/16 (D) in.)

Maximum 1 kg (2.2 1b.)

203.2 (X) x 152.4 (Y) x 31.8 (Z) mm (8 (X) x 6 (Y) x 1-1/4 (Z) in.)
X andY axes: 0.1to 1 mm/s, 1 to 15 mm/s (0.0039 to 0.59 in./s)

Z axis: 0.1to 1 mm/s, 1 to 6 mm/s (0.0039 to 0.23in./s)

AST (Active Surface Tracking) system

3D Cutting mode: 0.05 to 7 mm (0.002 to 0.27 in.)

Engraving mode: 0.05 to 1 mm (0.002 to 0.039 in.)

Composition: Resin (acrylic, modeling wax, ABS, polyacetal, polycarbonate, styrenefoam,
etc.), wood, and plaster

Maximum thickness: 30 mm (1-1/8in.)
0.01 mm/step (0.00039 in./step)

12 W (DC motor)

4,000 to 15,000 rpm

Yes

3.175mm (1/8in.)

Parallel (compliant with IEEE 1284)

Movement button, (joystick type) Power button, View button, Origin Set button, Speed
control, and Spindle Speed control

Z-axislight, Power light, View light, and Origin Set light

Dedicated AC adapter

Input: AC 100 to 240 V £10%, 50/60 Hz

Output: DC 19V, 2.1A

Maximum during operation: 0.6 A at 100V, 0.27 A at 240 V

Standby: Lessthan 45 dB (A)

No-load operation: Less than 70 dB (A) (according to SO 7779)

515.2 (W) x 368.3 (D) x 270.6 (H) mm (20-5/16 (W) x 14-1/2 (D) x 10-5/8 (H) in.)
10.9kg (24 1b.)

673 (W) x 518 (D) x 412 (H) mm (26-1/2 (W) x 20-3/8 (D) x16-1/4 (H) in.)
15.5kg (34.21b.)

Temperature: 5 to 40 °C (41 to 104 °F)

Relative humidity: 35 to 80% (no condensation)

AC adapter, power cord, cutter, cutter holder, depth regulator noses (large and small), adhesive
sheet for mounting material, test-use plate material, hexagonal screwdriver, hexagonal
wrenches (large and small), Roland Software Package, User's Manual
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L]

Interface Specifications

Parallel

Rating Compliant with | EEE 1284: Nibble mode

Input signals STROBE (1 hit), DATA (8 bits), SLCT IN, AUTO FEED, and INIT
Output signals BUSY (1 bit), ACK (1 bit), FAULT, SLCT, and PERROR
Input/output signal level TTL level

Transmission method Asynchronous
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Please read this agreement carefully before opening the sealed
package or the sealed disk package

Opening the seal ed package or sealed disk package implies your acceptance of the terms and conditions of this agreement.
If you do NOT accept this agreement, retain the package UNOPENED. (Thisproduct isjust oneof included items. Please
be aware that any amount of the purchase price will not be refunded for return of this product as asingle item, regardless
of whether the package is opened or unopened.) The enclosed Roland product is a single user version.

Roland License Agreement

Roland DG Corporation ("Roland") grants you a non-assignable and non-exclusive right to use the COMPUTER
PROGRAMS in this package (" Software") under this agreement with the following terms and conditions.

1. Coming into Force Thisagreement comesinto force when you purchase and open the seal ed package
or sealed disk package.
Theeffective date of this agreement isthe date when you open the sealed package
or sealed disk package.

2. Property Copyright and property of this Software, logo, name, manual and all literature

for this Software belong to Roland and its licenser.

The followings are prohibited :

(1) Unauthorized copying the Software or any of its support file, program module
or literature.

(2) Reverse engineering, disassembling, decompiling or any other attempt to
discover the source code of the Software.

3. Bounds of License Roland does not grant you to sub-license, rent, assign or transfer theright granted
under this agreement nor the Softwareitself (including the accompanying items)
to any third party.

You may not provide use of the Software through time-sharing service and/or
network system to any third party who is not individually licensed to use this
Software.

You may use the Software by one person with using a single computer in which
the Software isinstalled.

4. Reproduction You may make one copy of the Software only for back-up purpose. The property
of the copied Software belongs to Roland.
You may install the Software into the hard disk of a single compuiter.

5. Cancellation Roland retains the right to terminate this agreement without notice immediately
when any of followings occurs :
(1) When you violate any article of this agreement.
(2) When you make any serious breach of faith regarding this agreement.

6. Limitations on Liability Roland may change the specifications of this Software or its material without
notice.

Roland shall not be liable for any damage that may caused by the use of the
Software or by exercise of the right licensed by this agreement.

7. Governing Law This agreement is governed by the laws of Japan, and the parties shall submit to
the exclusive jurisdiction of the Japanese Court.
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